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Мавзу:      Makroslar yaratish, makroslar bilan ishlash. VBA tilida modullar 

yaratish 
 
Режа: 

1. Макросларни яратиш техникаси 
2. Мakroslar bilan ishlash 

      3. VBA tilida modullar yaratish 
 
 
 

            Макрослар ойнаси малумотлар базаси ойнасидаги Макроси қўшимча 
варақасидаги Создать (яратиш) ёки Конструктор тугмасини босигда 
очилади. Ойна тўртта устунни ўз ичига олади.  

� Имя макроса (Макрос номи) 
� Условие (Шарт) 
� Макрокоманда (Макрокоманда) 
� Примечание (Изоҳ) 
Урнатилган бўйича янги макрос яратилаётганда фақатгина 
Макрокоманда ва Изоҳ 

Устинлари акс этади. Қолган устинларни номойиши макрослар номи опсияси 
воситаси буйича ва Вид менюсида шарт буйича урнатилади. Агар айна бир 
неча макросларни уз ишига олса, бериш лозим булган макрос номини Имя 
макроса устида курсатилади. Макрослар номлари курсатилаётганда 
қайтаришлари булмаслиги керак. Условие устунида макросни фақат бир 
қисми бажарилиши учун шарт киритиш (мантиқий ифода) амалга 
оширилади. Макрокоманда устинида бажариш лозим булган ҳаракатлар 
(макрокомандалар) керакли кетма-кетликда саналиб чиқилади. Дастурга 
шарҳ сақловчи Примечание устуни макрос бажарилганда дастур томонидан 
итиборга олинмайди, бироқ уни тулдириш тавсия этилади, чунки бундай 
ҳолда макрос матни тушунарлироқ. 
       Макросни кийин булмаган процессларни автоматизациялаш учун ишлаб 
чиқариш қулайдир, хусусан бир неча форма яки ҳисоботларни очилиши ва 
ёпилиши, бир неча ҳужжатларни экранга ёки босмага босиб чиқариш ва 
бошқалар. 
       Макросларни яратилиши ва қулланилиши урганган ҳолда, макрос 
ёрдамида малумотлари базасида бир неча обьектларни очилиш мисолини 
куриб чиқамиз. Аниқ операцияларни автоматизатсиялаш учун мулжалланган 
малумотлар вазасида оператор куп болмаган бир хил муқдордаги обьектлар 
билан ишлайди. Хар бир база билан ишлаш сианс бошида қушимча керакли 
обьектларни очиш учун қушимча вақт кетади. Бу жараённи тезлатишга 
ҳаракат қиламиз: керакли ҳужжатларни очувчи ва аниқ тартибда экранга 
жойлаштиривчи макрос яратамиз: 

  
� Янги малумотлар базаси ойнасини очинг. 



� Макросы қушимча саҳифасига утинг ва Создать тугмасини босинг, 
бунинг натижисида макросни Конструктор ойнаси очилади. 

� Экранда ҳам малумотлар базаси ойнаси, ҳам макрос ойнаси акс этиши 
учун Окна менюсидаги Слева направо (чаптан унгга) буйругини 
амалга оширинг. 

� Малумотлар базаси ойнасида Формы қушимча саҳифасига утинг. 
� Уқитувчилар буйича соатлар миқдори фомасига белги қуйинг, 
сичқонча ёрдамида макрос жойлаштиринг. Майдончада Открыть 
форму (формани очиси) макрокомандаси пойда булади, шундай қилиб, 
макросда Кол-часов по преподавателям (Уқитувчилар буйиша соатлар 
миқдори) формасини очиш операцияси қушилади. 

� Примечание устунида ҳудди уша қаторга шундай матн киритинг: “ 
Кол-часов по преподавателям ” формасини очинг. 

�  [Enter] клавиши ёрдамида макрокаманда устунининг иккинчи каторига 
утинг 

� Шу ҳаракатни очилиши керак булган ҳамма обьектлар (мисол учун, 
Распределений предметов(Дарисларни тақсимлаш), Список 
преподователей (Уқитувчилар руйхати) жадваллари) учун қайтаринг. 

� Макрокаманда устунининг кейинги буш ячейкасини босинг ва кириш 
мумкин булган макрокамандалар руйхатини очинг. Выполнить 
команду (буйруқни бажариш) буйруғига белги қойинг. 

� Аргументы макрокаманды соҳасида Команда майдончасини ишга 
соламиз ва руйхаттан Tile Vertically елементини танлаймиз. Шундай 
қилиб, агар бир неча ойна очилса, макрокаманда экранни булиш 
операциясини узи ичига олади. 

� Файл менюсидан Сохранить (сақлаш) буйругини чақиринг ва 
макросни Размещение на экране номи остида сақлаб қойинг. 

 

 



 
Размещение на экране(экранда жойлаштириш) макросини ишга 
туширилгандан сунг ҳамма керакли малумотлар базасининг обьектлари 
юкланади ва керакли ҳолда жойланади.  
 

 
 
Хар қандай макрокамандани амалга ошириш унинг аргументларининг 
қийматига боғлик (бази макрокамандалар, мисол учун Развернуть(ёйиш) 
аргументларига эга эмас). Фойдаланувчи макрокамандаларнинг синтаксисни 
ёдлап олиши керак эмас-барча аргументлар бунинг учун махсус макрос 
ойнасини пастки қисмида жойлашган майдончасига киритилади. Агар рухсат 
этилган қийматлар топлами бази аргументлар учун чегараланган булса, 
Ассess уларнинг руйхат сифатида расмийлаштирилади. Аргументларни 
клавиятура ёрдамида киритиш мумкин, бироқ, мавжуд булмаган 
қийматларни бермаслик учун руйхатдан танланган яхшироқдир. 
Аргументларни макрос ойнасининг пастки қисмида қандай жойлашган булса, 
шундай бериш тавсия этилади. 



 

 
   
       Макросни ишлаб шиқаришни биз обьектларни очиш, яни малумотлар 
базасининг ойнасидан мос равишдаги обьектларни макроснинг Конструктор 
ойнаси ячейкаларга ташлаб утиш йўли билан макрокамандаларни киритишни 
бошлайди. Шу билан бирга Ассеss қайси обьект ҳақида гап бораятганини 
автоматик узи таниб, мос равишда макрокамандаларни танлайди: форма учун 
Открыть(очиш) форму очиш яки жадвал учун Откритьтаблицу (жадвални 



очиш). Ташиб утилган обьектларнинг номи макрокаманданинг аргументлар 
соҳасида Имя(ном) параметри  қиймати сифатида пайдо булади. 
      Макрокамандада обьект номи очилиши аргументлар соҳасига клавиятура 
орқали киритиш мумкин. Асосан макрос бажараётганда очилаётган обьект 
мавжуд булиши керак, акс холда дастур хатолик ҳақида хабар беради. 
         Режим майдончасига киритилган Макрокаманда очилиши обьектининг 
кейинги аргументи экранда акс этиш режимини аниқлайди. Ушбу 
аргументнинг рухсат этилган қиймати Режим менюсидадаги опсияларга мос 
келади. 
          
Режим 
аргумент

и 
қиймати 

Қулланиш Тəриф 

Печать Ҳисоботни Ҳисоботни  босмага чиқаришни 
беради 

Форма Формани Форма режими активлаштиради 
Таблица Жадвал, суров, формани Тулдириш ва узгартириш 

режимини активлаштиради 
Конструкт

ор 
Жадвалнинг, суровнинг, 
форманинг 

Конструктор режимини 
активлаштириди 

Просмотр Жадвални, суровни, 
ҳисоботни, формани 

Саҳифани курип чиқиш 
режимини урнатади 

  Выполнить команду макрокаманда ёрдамида Ассеs менюсидаги купгина 
буйруқни бажариш мумкин. Бажарилаётган буйруқнинг номи Команда 
майдончасида аргумент сифатида курсатилади. Меню қаторлари таркиби 
актив обьект ахволи ва типига боғлик. Выполнить команду 
макрокамандасидан фойдаланилганда, қайси обьект охирги булиб 
активизайия қилинган ва қайси режимда жойлашганлигига этибор бериш 
керак. Бундан меню камандасининг очиқлилиги ва бажарилиш туғрилигига 
боғлиқ. 

 
Microsoft Access  Макрокамандалари 

Категория Вазифаси Макрокаманда 
Форма ва 
ҳисоботларда 
малумотлар 
билан ишлаш  

Малумотларни 
танлаш  

Применить Фильтр (ApplyFilter)  

 Малумотлар 
буйича кучиш  

СледующаяЗапись(FindNext) 
НайтиЗапись(FindRecord) 
КЭлементуУправления(GoToControl) 
НаСтраницу(GoToPage) 
НаЗапись (GoToRecord)  

 Малумотларни Обновление(Requery) 



ёки экранни 
янгилаш  

ПоказатьВсеЗаписи (ShowAllRecords )  

Бажариш  Камандани 
бажариш  

Выполнить Команду (RunComraand)  

 Макрос, 
процедура ёки 
суровни 
бажариш  

ЗапускМакроса(RunMacro) 
ЗапускПрограммы (RunCode) 
ОткрытьЗапрос (OpenQuery) 
3anycк 3anpoca SQL (RunSQL)  

 Бошқа иловани 
бажариш  

Запуск Приложения (RunApp)  

 Бажаришни 
узиш  

ОтменитьСобытие(CancelEvent) 
ОстановитьВсеМакросы(StopAllMacros) 
ОстановитьМакрос (StopMacro)  

 Microsoft 
Accessдан 
чиқиш  

Выход (Quit)  

Импорт/экспо
рт  

Microsoft Access  
Обьектларни 
бошқа 
иловаларга 
узатиш  

ВывестиВФормате(OutputTo) 
ОтправитьОбъект (SendObject)  

 Малумотлар 
форматини 
узгартириш  

ПреобразоватьБазуДанных (Transfer Database) 
ПереносБазыДанныхSQL(TransferSQLDatabase) 
Преобразовать ЭлектроннуюТаблицу (Transfer 
Spreadsheet)  
ПреобразоватьТекст (TransferText )  

Обьектлар 
билан ишлаш  

Обьектдан нусха 
олиш, Обьект 
номини 
узгартириш ва 
обьектни сақлаш 

КопироватьОбъект(CopyObject) 
Копировать Файл БазыДанных (CopyDatabase 
File)  
Переименовать (Rename) Сохранить (Save)  

Узгалар  Махсус ёки хос 
инструментлар 
панелини 
экранга чиқариш 
ёки бекитиш 
Товуш 
сигналини 
бериш  

ПанельИнструментов (ShowToolbar)  
Сигнал (Веер)  
 

 
 

Назорат учун саволлар: 
 

1. МББТ характеристикалари ва турлари? 



2. Dbase, Paradox маълумотлар базаси? 
3. Dbase, Paradox маълумотлар базасига чекловлар ўрнатиш усуллари? 
4. Ms Access маълумотлар базасида ишлаш жараёнлари? 
 

 
 

Адабиётлар. 
1. К. Дейт. Введение в системы баз данных. 7-е изд. М.: СПб.: Вильямс, 

2000.  
2. Олифер В.Г., Олифер Н.А. Компьютерные сети. Принципы, 
технологии, протоколы. - СПб.: Питер, 2001. 

3. Зайнидинов Х.Н., Хамдамов У.Р., Мухтарова Г.Х. Методические 
указания к лабораторным работам по курсу «Информационные 
системы» Фергана – 2006 

4. Робинсон С. MicrosoftAccess - 2000./Учебный курс. - СПб.: Питер, 
2002. 

 
 
 
 

Кнопкалы  бос форма  
 

Кнопкалы  бос форма пайда етиў ушын иқтиярый форманы жойбарлаймыз. 
Буның ушын 

� Мағлыўматлар айнасы бөлиминен Форманы таңлаймыз 
� Создать кнопкасын басып Новая форма айнасын ашамыз 
� Бул айнадан Конструкторды таңлаймыз OK басылады. Бос форма 
пайда болады 
 

 
 

 
 



� Бул форманы «кнопкалы бос форма» аты менен сақлаймыз. 
Форманы жаўып МБ айнасына қайтамыз. 

� МБ айнасының форма объекти устинде  мышь оң кнопкасы 
арқалы контекстли менюден  Параметры запуска ны таңлаймыз. 

 
  

 
 

 
 

� Вывод формы/ страницы айнасына «Кнопкалы бос форма» 
форманы таңлаймыз 

 
 

� Программаны жаўамыз файлды қайта жүклеймиз.Экранда форма 
ашылады 



 

 
Томендеги жумысларды əмелге асырыў ушын макрослардан пайдаланамыз  
 
 

 
 
 
 
 
 



 
 
 

 
 

Шартлерге байланыслы макрослар 
 

Шартлерге байланыслы макросларды төмендеги мысалда көрейик . 
Мəлим бир сораўдан пайдаланып  төмендеги форма жойбарластырылған 
болсын.  

 



 
 

Бизден факультет бойынша саралаў талап етилген Бyның ушын: 
1. Форма конструктор жағдайында болганда оның примечание бөлимине 

Группа переключателя асбаптан пайдаланып группа орнатамыз. 
    

 
Демек группада  уш кнопка орнатылған болып, оларға сəйкес мəнислер 1,2,3 
ден ибарат. Грухтың свойства айнасынан оған «Таңлаў» деп ат беремиз   
 

 



 

 
 

 
 

2. Факультетлер бойынша сораўды əмелге асырыў ушын жаңа макрос 
жаратамыз. Оны «Танлаў» атлы грух пенен байланыстырамыз. 
Буның ушын: Төмендеги суўрет 
 



 
Изиндеги қатарларды да сондай етип толтырамыз. Тек сəйкес қатарлардың 
Аргументы макрокоманды бөлимине сəйкес тəризде [Fak]q”ekonomika”ҳəм 
[Fak]q”RGF” жазылады. 

 

 
 
 

� Макростын 3- қатарындағы макрокоманда  барлық жазыўларды 
көрсетеди(филтирлеўди бийкар етеди). Макркоманда қатарына  
Показат все записи жазылады.  Бул макрокоманда аргументге ийе 
емес. 

� Макростын 4- қатарындағы макрокоманда  «Факультет» майданына 
қайтыўды тəмийинлейди . 

� Макросты М_fak ат пенен сақлаймыз. 
 



F_Tanlaw форманы конструктор жағдайында ашамыз грухтың свойства 
айнасынан После обновления қатарына пайда болган макрос атын 
орнатамыз. Свойствоны жабамыз форманы конструктор жағдайга откеремиз. 

 
   

 
 
 
 

Мавзу:      “Klient – server “ texnologiyasi  
 

Режа: 
 

1. Локал ва глобал архитектурали ахборот   системалари  
2. Файл-сервер» архитектураси.  
3. Клиент-сервер» архитектураси. Икки ва уч сатхли «клиент-сервер» 
архитектураси. 
 
Таянч сўзлар: Локал ва глобал архитектура, «файл-сервер» архитектураси, 
«клиент-сервер» архитектураси. 
 

 
1. Локал ва глобал архитектурали ахборот тизимлари 

 
Ахборот тизимлари асосан икки хил архитектурада курилади. Улар 
куйидагилардан иборат: 
– локал маълумотлар базали ахборот тизимлари; 
– глобал маълумотлар базали ахборот тизимлари. 
 
Локал  архитектура. 
Локал маълумотлар базаси (МБ) ундан фойдаланаётган 
дастур жойлашган компьютернинг узида жойлашган 



булади. 
Бундай холларда ахборот тизимлари локал архитектурада 
курилган деб юритилади. 
МБ билан ишлаш бир  фойдаланувчили  режимида амалга 
оширилади. 

 
Расм 6.1.Маълумотлар базасинил яратиш схемаси 

 
 BDE (Borland Datebase Engine). Borland mag`liwmatlar bazasinin` 

mashinasi. Onin` quramina programmalar toplami kirgizilgen bolip, olar lokal 
ha`m klent server tu`rinin` MB na usinis etiwdi ha`m onnan paydalaniwdi 
sho`lkemlestirip beredi. 
 
 

2. «Файл-сервер» архитектураси. 
 

•«Файл-сервер» архитектураси купинча фойдаланувчилари сони куп булмаган 
компьютер тармокларида кулланилади. Бундай тизимни жорий килиш учун 
Paradox ва dBase туридаги локал маълумотлар базасидан фойдаланилади. 
• Бундай архитектурани афзаллиги шундан иборатки, уни жорий килиш жуда 
оддий булиб,  фойдаланиладиган дастурлар компьютер тармогига боглик 
булмай факат битта фойдаланувчига мулжаллаб яратилади.   
 
 

 
Расм 6.2.Файл-сервер архитектураси схемаси 

 
«Файл-сервер» архитектура камчилликлари. 
«Файл-сервер» архитектура куйидаги камчилликларга эга:  



– Фойдаланувчи хар доим узининг МБ локал копияси билан ишлайди. Агар 
бирон бир жадвалдаги маълумотларни узгартириш учун суров жунатса, у холда 
сервер унга талаб килинган МБ янги локал копиясини узатади. Бундай холларда 
тармокда 
фойдаланувчилар ва сервер уртасида катта хажмдаги маълумотларни айланиши 
хисобидан тармок юкламаси ошиб кетади ва ахборот тизимини ишлаш тезлиги 
пасаяди. 
– Хар бир компьютерда узини маълумотлар базасини локал копияси булганлиги 
учун шу копияда бажарилган  узгартиришлар бироз вакт бошка 
фойдаланувчиларга маълум булмайди. 
 
Масофадаги МБ 
Масофадаги МБ тармок сервери компьютерида жойлаштирилади, МБ билан 
ишловчи дастурлар эса фойдаланувчи компьютерларида жойлашган булади. 
Бундай холларда биз «клиент-сервер» архитектураси билан ишлаймиз.  Бунда 
ахборот тизими сервер ва клиент кисмларга ажратилади. Сервер компьютери 
клиентлардан алохида жойлаштирилади. Клиентлардан алохида 
жойлаштирилган серверлар масофавий серверлар хам деб юритилади.  Клиент - 
эса бу фойдаланувчи дастуридир.  Клиент бирор маълумотни олиш учун 
маълумотлар базаси жойлашган масофавий серверга суров жунатади. Суровлар 
– реляцион маълумотлардан фойдаланилганда серверларга мурожат килишни 
стандарт воситаси булган  SQL (Structured Query Language) тилида яратилади. 
Суров кабул килингандан кейин сервер уни SQL серверга йуналтиради. 
Маълумотлар базаси сервери – бу масофавий МБ бошкарувчи, суровларни 
бажарилишини ва суров натижаларни клиентга узатилишини таъминловчи 
махсус дастурдир. 

 
3. «Kлиент-сервер» архитектураси. Икки ва уч сатхли «клиент-сервер» 

архитектураси. 
 
«Клиент-сервер» архитектурасида клиент бирор маълумотни олиш учун суров 
жунатади ва факат суровда талаб килиган маълумотларни олади. Барча 
суровларни кайта ишлаш масофавий серверда амалга оширилади. 
 
«Клиент-сервер» архитектураси куйидаги афзалликларга эга: 
 
• Тармок юкламасини пасайиши, энди факат керакли маълумотлар 
алмашинилади. 
• Ахборот хавфсизлигини ошади, чунки барча клиентларни суровларини кайта 
ишлаш серверда жойлашган ягона дастур оркали амалга оширилади. Сервер 
барча фойдаланувчилар учун МБ дан фойдаланишни умумий коидасини 
урнатади,  клиентларни маълумотларга булган мурожат режимларини 
бошкаради, хар хил фойдаланувчилар томонидан бита маълумотни баравар 
узгартирилишини чеклайди. 



• Клиент дастурларини мураккаблиги камаяди, чунки уларда МБ ни 
бошкарувчи ва назорат килувчи дастур кодлари мавжуд булмайди. 
 

 
Расм 6.3.Икки сатхли клиент-сервер архитектурасининг  схемаси. 

 
Катта  клиент. 
• Delphi дастурларни маълумотлар базаларини бошкариш тизимларига (МББТ) 
богланиши SQL-Links драйверлари оркали амалга оширилади.  
• Келтирилган архитектура икки сатхли хисобланади, яъни клиент дастури ва 
маълумотлар базаси серверидан иборат 
• Клиент дастури «кучли» ёки «калин» клиент деб аталади. 

 
Расм 6.4. Уч сатхли клиент-сервер архитектурасининг  схемаси. 

 
Кичик  клиент. 
• Уч сатхли архитектурада маълумотларга мурожат килиш ва уларни кайта 
ишлаш 
воситаларини ва дастур кодларини бир кисми клиент дастурларидан ажратилиб 
дастурлар серверига юклатилади. 
• Клиент дастурлари бунда «кучсиз» ёки «кичик» клиент деб юритилади.  
• Дастурлар серверида барча клиентлар дастурлари учун умумий булган 
воситалар ва 
дастур кодларини жойлаштириш кулайдир. 
 



Уч сатхли архитектурани афзалликлари. 
Уч сатхли «клиент-сервер» архитектурасини асосий афзалликлари  
куйидагилардан иборат: 
• МБ серверини юкламаси бир кисм операцияларни бажарилиши дастурлар 
серверига утказилганли билан камайтирилган; 
• Клиент дастурлари улчами камаяди ва соддалашади (ортикча кодларни олиб 
ташланиши хисобидан); 
• Барча клиентлар учун ягона муносабат; 
• Клиентлар созлашларини соддалашуви (дастурлар серверидаги умумий кодни 
узгариши билан автоматик равишда барча клиент дастурларини  муносабати 
узгаради). 
 
 
 
 

Назорат учун саволлар: 
1. Локал  архитектурали ахборот тизимлари? 
2. Глобал архитектурали ахборот тизимлари?  
3. Ахборот тизимларини «файл-сервер» архитектураси?  
4. Ахборот тизимларини «клиент-сервер» архитектураси?  
5. Икки сатхли «клиент-сервер» архитектураси? 
6. Уч сатхли «клиент-сервер» архитектураси? 
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технологии, протоколы. - СПб.: Питер, 2001. 

3. Б.Ю. Ходиев и др. Введение в базы данных и знаний. Ташкент. 
Изд.ТГЭУ. 2003. – 133с. 

 
 
 
Мавзу:   Маълумотлар базасининг дастурий таъминоти. Маълумотлар 
базаси билан ишловчи инструментал воситалар ва компонентлар.  
 
Режа: 

1. Маълумотлар базаси дастурлари ва уларнинг дастурий воситалари. 
2. Дастур учун яратилган асосий ва қўшимча компоненталар. 
3. Маълумотлар базаси билан ишловчи инструментал воситалар ва 
компонентлар 

4.  DDL ва  DML.дастурлари. 
 



Таяниш сўзлар;.  Маълумотлар базаси дастурлари ва уларнинг дастурий 
воситалари, асосий ва қўшимча компоненталар., DDL ва  
DML.дастурлари. (SQL – Structured Query  

Language),  Borland Database Engine (BDE),Data Controls, ADO (Active Data 
Objects). 
 
 

МБ дастурлари 
МБ локал дастурлари – бир сатхли дастурлар деб ютирилади 
МБ «клиент – сервер» дастурлари – куп сатхли дастурлар деб юритилади 

 
МББТ тил воситалари 

Замонавий МББТ тил воситалари таркибига 
куйидагилар киради: 
• Маълумотларни ёритиш тили, - маълумотларни мантикий 
структурасини ёритишга мулжалланган; 
• Маълумотларни кайта ишлаш тили, маълумотлар устида 
асосий киритиш, узгартириш ва танлаш операцияларини 
бажарилиши таъминлаш; 
• Структураланган суровлар тили (SQL – Structured Query  
Language), МБ структурасини бошкариш, маълумотларни 
бошкариш ва кайта ишлашни таъминлаш; 
• Намуна буйича суровлар тили (QBE – Query By Example),  
МБ учун суровларни визуал яратишни таъминлаш. 

МБ билан ишловчи воситалар 
• МБ билан ишлашга мулжалланган воситаларни икки турга булиш мумкин: 
 – инструментал инструментал воситалар воситалар; ; 
 – компонентлар компонентлар. . 
 • Инструментал  воситаларга МБ хизмат  курсатувчи махсус дастурлар  ва 
дастурлар пакетини киритиш мумкин. . 
 • Компонентлар МБ билан операциялар бажарувчи дастурларни яратишга 
мулжалланган элементлардир  

 Инструментал воситалар 
• Borland Database Engine (BDE) – дастурлардан туриб МБ мурожатни 
амалга ошириб берувчи драйверлар ва библиотекалар тупламидан 
иборат процессордир. 
• BDE Administrator –BDE хар хил параметрларини созловчи дастур. 
• Database Desktop – жадваллар, QBE ва SQL суровларни яратувчи ва 
узгартирувчи дастур. 
• SQL Explorer – МБ ни курсатувчи ва узгартирувчи дастур. 
• SQL Builder –SQL суровларни визуал яратишга кумаклашувчи дастур; 
• SQL Monitor – МБ да SQL суровларни бажарилиш тартибини кузатувчи 
дастур. 
• Data Pump – МБлари уртасида маълумотларни кучирувчи дастур.  
• InterBase Server Manager – InterBase серверини ишга тушурувчи дастур 



• SQL Links – корпоратив МББТ мурожат драйверлари. 
• InterBase Server – InterBase серверини клиент ва сервер кисми. 

 МБ учун компонентлар 
• • МБ МБ компонентлари компонентлари иккига иккига булинади булинади: : 
– Визуал 
– Новизуал 
• Новизуал компонентлар жадвал ичида жойлашган маълумотларга мурожатни 
амалга оширишга мулжалланган. Улар МБ жадваллари ва визуал компонентлар 
орасида иштирок этади.  
• Визуал компонентлар дастурларни интерфейс кисмини яратишда ишлатилади. 
Улар ёрдамида фойдаланувчи жадваллардаги маълумотларни куриши ва 
узгартириши мумкин. 

 
МБ учун компонентлар 

• МБ билан ишловчи компонентлар куйидаги панелларда жойлашган: 
– Data Access 
– Data Controls 
– dbExpress 
– BDE 
– ADO 
– Decision Cube 
– QReport 
– InterBase 

 
 



 
 
 

Data Controls панели 
•DBGrid– таблица; 
• DBNavigator – навигацион интерфейс; 
•DBText– изох; 
• DBEdit – бир каторли матн редактори; 
•DBMemo– куп каторли матн редактори; 
•DBImage– график компонент; 
•DBListBox– руйхат яратиш компоненти; 
• DBComboBox – очиладиган руйхат; 
• DBCheckBox – индивидуаль танлаш компоненти; 
• DBRadioGroup – бир бирига боглик танлаш компонентлари 
гурухи; 
• DBLookupListBox – бошка маълумотлар тупламидан 
яратиладиган руйхат компоненти; 
• DBLookupcomboBox – бошка маълумотлар тупламидан 
яратиладиган очиладиган руйхат; 
•DBRichEdit– тулик функцияли редактор; 
•DBCtrlGrid– яхшиланган таблица; 
•DBChart– диаграмма. 

 
BDE панели 

• Table – МБ жадвали асосидаги маълумотлар туплами; 
• Query –SQL-суровларга асосланган маълумотлар туплами; 
• StoredProc – серверда сакланадиган чакирув процедураси; 
• DataBase – МБ билан уланиш; 
• Session – МБ билан жорий иш сеанси; 



• BatchMove – маълумотлар гурухи усти  амаллар бажариш; 
• UpdateSQL –SQL-суровга асосланган,  маълумотлар тупламини узгартириш; 

 
 

ADO панели 
• ADO панелида ADO (Active Data Objects)  технологияси билан маълумотларни 
бошкаришга мулжалланган компонентлар жойлашган: 
– ADOConnection – уланиш; 
– ADOCommand – команда; 
–ADODataSet – маълумотлар туплами; 
–ADOTable –Table маълумотлар туплами; 
– ADOQuery –Query маълумотлар туплами; 
– ADOStoredProc – сервер чакирув процедураси; 

 
 
 
 

InterBase панели 
• InterBase панелида InterBase сервери билан ишловчи компонентлар 
жойлашган: 
– IBTable – Table маълумотлар туплами; 
– IBQuery – Query маълумотлар туплами; 
– IBStoredProc – сервердаги чакирув процедуралари; 
– IBDatabase – МБ билан уланиш 
– IBTransaction – транзакция; 
– IBUpdateSQL – SQL-суров асосида маълумотларни 
узгартириш; 
– IBDataSet – маълумотлар манбаи; 
– IBSQL – SQL-суровни бажариш; 
– IBDataBaseInfo – МБ хакида маълумот; 
– IBSQLMonitor – SQL-суровларни бажарилиш монитори; 
– IBEvents – сервераги ходисалар; 

 



 
QReport панели 

• QReport панелида хисоботлар тайёрлашга мулжалланган 
компонентлар жойлашган: 
• QuickRep – хисобот шаблони; 
•QRSubDetail–«асосий-буйсинувчи» богланган жадваллар учун хисобот сатри; 
• QRStringsBand – хисоботни белгили сатри; 
• QRBand – хисобот сатрлари; 
• QRChildBand – хисоботни бошка сатр кошидаги сатри; 
• QRLabel – метка; 
• QRDBText – матнли катор; 
•QRExpr– математик кетма-кетликлар; 
•QRSysData– тизим маълумотлари; 
•QRMemo– куп каторли матн; 
• QRExprMemo – куп каторли математик кетма-кетликлар; 
• QRRichText – форматланган матнлар; 
• QRDBRichText – жадвал учунформатланган матнлар компоненти; 
•QRImage– график компонент; 
• QRDBimage – жадвал учун график компонент; 
•QRPreview– хисоботни куриш ойнаси; 
• QRChart – диаграмма. 

 

 
 
 
 
 

 



 

 

 
 

 
 



 
 

 
 

 
 

 



 
 

 

 
 



 

 
 

 

 
 



 
 
 
 

 
1. Mag`liwmatlar bazasin basqaratug`in qosimshalar duziw ushin Delphi 

qurallari 
 
 Delphi  quramina kiriwshi Mag`liwmatlar bazasin basqariwda isletiletug`in  
qosimshalardi  duziw ha`m isletiw  qurallarina to`mendegiler kiredi: 

- BDE (Borland Datebase Engine). Borland mag`liwmatlar bazasinin` mashinasi. Onin` 
quramina programmalar toplami kirgizilgen bolip, olar lokal ha`m klent server tu`rinin` MV na 
usinis etiwdi ha`m onnan paydalaniwdi sho`lkemlestirip beredi. 

- SQL LINKS.  Basqa mag`liwmatlar bazasin basqariw sistemalari (MBBS) menen 
(ma`selen, SysBase, Oracl, MsSQL Server) islew ushin drayverler.  Delphi sistemasi Paradox 
ha`m Dbase MBBS lari ushin SQL di isletpeydi, BDE ja`rdeminde orinlaydi. 

- DBE adminstrator- bul utilita bolip, MB na psevdonimler, parametrler ha`m MV ornatiw 
ushin isletiledi. Delphi de duzilgen qosimsha ja`rdeminde MB menen islew waqtinda MB nan 
paydalaniw onin` psevdonimi boyinsha a`melge asiriladi. 

DateBase Desctop(DBD). Mag`liwmatlar bazasin ko`riw, redaktorlaw ha`m 
sho`lkemlestiriw ushin arnawli qural (utilita). Bul utilita tiykarinan Paradox ha`m DBase   
MBBS ushin onin` tablitsalari menen islewge qaratilg`an bolip, ayirim jag`daylarda basqa sirtqi 
MBBS tablitsalari menen islewde de paydalaniladi. Qosimshalardin` o`z ara baylanisinin` 
uliwma modeli to`mendegi sxemada berilgen: 



 
 
 
-DateBase Explorer (SQL Explorer). MB psevdonimi, konfiguratsiyasi ha`m duzilisin 

ko`riw, ha`mde MB tablitsasina soraw beriw utilitlerin o`z ishine aladi.   
- SQL monitor. SQL sorawlarin orinlaw qurali.  
-Visual Query Builder.  Delphi quramina kiriwshi qural bolip, SQL – sorawlarin 

avtomatlastiriwdi sho`lkemestiredi. 
- Date Distionary – mag`liwmatlar so`zligi. MB tablitsasi maydanlari atributlarin 

saqlaytug`in qural. 
- MB menen islew ushin vizual bolmag`an komponentalar. Vizual bolmag`an 

komponentalar qosimshalar menen MB tablitsasini baylanistiriwg`a xizmet etedi. Bul 
komponentalar Date Access komponentalar palitrasinda jaylasqan. 

-MB menen islew ushin vizual komponentalar. Delphi vizual komponentalari 
mag`liwmatlar toplami jaziwlarin ( ma`selen, komponentaTDBG) sa`wlelendiriw ushin ha`m 
paydalaniwshig`a qolay interfeys jaratiw ushin isletiledi. Bul komponentalar Data Controls 
komponentalar palitrasinda jaylasqan. 

- Esabatlar duziw ushin komponentalar. Bul komponentalar 20 dan artiq bolip, olar 
Qreport komponentalar palitrasinda jaylasqan esabatlardi duziw ushin isletiledi. 

MB tayar qosimshasi menen islew ushin qurallardin` uliwma duzilisi to`mendegi 
sxemada keltirilgen: 

        

МБ ислеў ушын 
қосымша 

BDE DateBase DesTop 

Локал МБ 
Paradox, Dbase 

BDE 
админстратор 

SQL 
Lincs 

Басқа МББС( Oracl, SyBase, 
MsSQL Server,Interbase  



 
Bul sxemag`a tiykarinan, biz to`mendegi izbe-izlik shinjirina iye bolamiz. 

Qosimsha => BDE=> MB 
Vizual  bolmag`an komponentalardan BDE g`a tuwiridan tuwiri shig`iladi, ol 

paydalaniwshi interfeysin ta`minleydi. Delphi ja`rdeminde MB si menen islew ushin jaratilg`an 
programmalardin` tiykarg`i qa`siyetleri olarda BDE nin` isletiliwiinde. BDE nin` tiykarg`i 
waziypasi  programmalar menen MB ortasinda baylanistiriwshi ko`pir waziypasin orinlaydi. 

 
2. Mag`liwmatlar bazasi menen islew ushin Delphi komponentalari  
 
Delphi  MB menen islewde jeterlishe ulken topar komponentalarina iye. 

Data Access ( mag`liwmatlarg`a ruxsat yaki mag`liwmatlardan paydalaniwg`a ruxsat) 
betlerinde MB in basqa mag`liwmatlar menen o`z-ara ta`sirinde isletiletug`in komponentalar bar. 
Olardin` ko`pshiligi vizual bolmag`an (ko`rinbeytug`in) bolip, o`z ishine tablitsa, soraw, ko`riw, 
o`zgertiw ha`m basqalar  tu`sindirmesin aladi.  

Data Controls ( mag`liwmatlar baylanisli elementlerdi basqariw) betlerinde tiykarinan 
vizual komponentalar bolip, olarg`a mag`liwmatlar menen baylanisli komponentalar deyiledi. 

Delphi mag`liwmatlar bazasi menen baylanis (og`an usinis) etiwi ushin Data Source 
komponentasin isletedi. Bul komponenta tuwiridan -tuwiri  mag`liwmatlardi belgilemeydi, ol 
Data Set  komponentasina usinis etedi. To`mendegi tablitsalarda vizual ha`m vizual bolmag`an 
komponentalar xarakeristikasi berilgen: 

 

MB menen islew ushin vizual bolmag`an komponentalar haqqinda mag`liwmat 

 
Komponent Waziypasi 
Tsession MV menen baylanis ornatiw seansi bolip, MB ashiwda, jabiwda  ha`m oni 

parametrli basqariwda isletiledi   
TDatabase MV. Bul komponenta qorg`alg`an MB menen birlestiriw protsessin 

basqariwshin xizmet etedi.  
TDatasource Mag`liwmat deregi. Mag`liumatlarg`a usinis etiw komponentalari menen 

mag`liwmatlardi sa`wlelendiriwkomponentalari ortasinda basqariwshi 

МБ 

BDE 

МБда ислеў ушын визуал 
болмаған компоненталар 

МБда ислеў ушын визуал 
болған компоненталар 
 



element waziypasin orinlaydi.  
TDataSet Klientler mag`liwmatlar toplamina, mag`liwmatlarg`a MB in mashinasinan 

paydalanbastan usinisetiw qurali sipatinda isletiledi. MB si menen islewde 
qa`siyet ha`m metodlardi aniqlaydi. 

TTable MB nin` tablitsasina kiriw qurali sipatinda xizmet etedi. 
Tquery Soraw. Mag`liwmatlar bazasini SQL tili ja`rdeminde tan`lap aliw 

imka`nini beredi. 
TIndex Dets MB tablitsasi indeksleri haqqinda mag`liwmat beredi 
TField Dets MB tablitsasi maydanlari haqqinda mag`liwmat beredi 
TBatch Move Bir MB toplamin basqasina ko`shiriw ushin isletiledi. 

 

MB menen islew ushin vizual  komponentalar haqqinda mag`liwmat 

 
Komponent Waziypasi 
TDBtext Mag`liwmatlar toplami maydaninin` ha`rekettegi jaziwin ko`rsetedi 
TDBEDIT Xa`rekettegi jaziwidi ko`riw ha`m maydan ma`nislerin o`zgertiwdi 

ta`minleydi 
TDBCheckBox Logikaliq tu`rge iye bolg`an maydannin` ha`rekettegi jaziwin ko`riw ha`m 

onin` ma`nislerin redaktorlawdi ta`minleydi. 
TDBMenu Menyu maydan ma`nislerin ( posle kommentariy) tekst redaktori rejiminde 

ko`riw ha`m o`zgertiriwdi ta`minleydi.  
TDBGrid MB tablitsasi. Mag`liwmatlar toplamin tablitsaliq ko`riniste shig`ariwdi 

ta`minleydi 
TDBNavigator MB navigatori. MB jaziwlarin jen`illestiriwdi ta`minleydi. Sonday-ak, 

jaziwlardi qoyiw, alip taslaw ha`m redaktorlaw imkanini beredi   
TDBChart  Mag`liwmatlardi grafikaliq ko`riniste ko`rsetiw ushin isletiledi 

 
 

 Vizual ha`m vizual bolmag`an komponentalar bir birler menen qa`siyetler ja`rdemine 
baylanisadi. Qa`siyetler tiykarinan qosimshalardi islep shig`iwda aniqlanadi.  
 

3. BDE administrator utilitasi menen islew  
  
Delphide qosimsha ja`rdeminde MB nan paydalaniw ushin  

Qosimsha=> BDE=>MB 
izbe-izligi orinlanadi. Bul soni bildiredi, ha`r qanday MB na qosimshadan usinis etilgende onin` 
aniq adresi BDE ge uzatiladi. BDE o`zinin` arnawli funktsiyalarin MB menen baylanisda 
isletiledi. BDE aniq mag`liwmatalr bazasi menen islegende to`mendegilerdi biliwi kerek. 
 - MB qaysi jerde jaylasqanlig`ini; 
 - MB parametrleri haqqindag`i mag`liwmatti 
 MB parametrleri ha`m onin` jaylasiwi MB psevdoniminde aniqlanadi. 
Psevdonim – MB da berilgen bir at bolip, MB logikaliq usinis etilgende isletiledi.  
 MB  psevdonimi BDE administrator utilitasi ja`rdeminde aniqlanadi. 
MB nin` ha`r bir tablitsasi ushin fayl duziledi. Tap sonday tablitsa indeksleri memo maydanlari 
ushin arnawli fayl duziledi. MB na programma ha`m utilitalardan usinis etiw MB nin` 
psevdoniminde a`melge asiriladi. Psevdonim BDE adminstrator utilitasi ja`rdeminde aniqlanadi. 
Psevdonim –qanday da bir at bolip, MBna Delphi komponenti qosimshalari (ma`selen Ttable 
ha`m Tquery) ta`repinen logikaliq usinis etiwde isletiledi. 



 Aytayiq, biz sho`lkemlestiriwimiz kerek bolg`an MB «S:\PROBA\» kataloginda 
jaylassin. Biz sho`lkemlestiretug`in  pvedonim ati aytayiq « Proba» bolsin. BDE adminstrator 
utilitasin iske tusiremiz. Tiykarg`i menyudan Oject/ New buyriqlarin tan`laymiz. Payda bolg`an 
aynadan duziletug`in MB turin aniqlaw ushin «Standart» parametrin o`zgertirmesten OK 
tuymesin basamiz. Shep aynada (MB adminstratori aynasinda) biz «Standart» atti ko`remiz ha`m 
oni «Proba»g`a  o`zgertemiz. On` aynada  MB parametrleri berilgen, ol jerde tek Path 
o`zgertiledi. Bul parametr MB katalogina joldi ko`rsetedi. Path atin ko`rsetip, on` aynadan ush 
tochkali tuymeni ha`m shep aynadan «Proba»ni tan`lap OK tu`ymesin basamiz.  MB ushin 
aniqlang`an psevdonimdi saqlaw ushin shep aynag`a kelip, mishkanin` on` tuymesin shirtildatip 
dialog aynadan «Apply» elementin tan`laymiz ha`m OK tuymesin basamiz. Keyin bolsa BDE 
adminstratorinan shig`amiz. 

 MB psevdonimini  du`ziwdi ja`nede shuqirraq ko`rip shig`ayiq. 

Onin` algoritmi to`mendegishe:      

1. BDE administrator utilitasi iske tu`siriledi. 

2. Menyudan Oject =>New buyrig`i beriledi. 

3. Aynadan Standart tu`ri o`zgertirilmesten OK tu`ymesi basiladi. 
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4. Shep aynadan Standart1 ati  jan`a psevdonim atina o`zgertiriledi. 
5. On` aynadan Path qatarina o`tilip, ush tochkali tuymeshe ha`m keyin OK basiladi. 
6. Menyudan Object =>Apply=>OK buyrig`i beriledi. 
7. BDE administratorinan shig`iladi.    
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4.  Mag`liwmatlar bazasi (MB) tablitsasin du`ziw 
 

 MB tablitsasin du`ziw ushin DataBase Desktop(DBD) utilitasin iske tusiriw za`rur. 
Utilitani iske tu`sirgennen keyin isshi psevdonim ornatiladi. Isshi psevdonimdi ornatiw ushin bas 
menyudan File=>Working Directory buyrig`in berip, keyin dizimge kiriwshi «Aliases» tan`lanip 
psevdonim ati «Proba» ko`rsetiledi ha`m OK tu`ymesi basiladi. 

  MB tablitsasin du`ziw ushin tiykarg`i  menyudan 
File=>New => Table buyrig`i orinlanadi. Payda bolg`an Create Table aynada MB tu`rin aniqlap, 
(ma`selen Paradox7 yaki Dbase Windows) OK tu`ymesi basiladi. Jan`adan payda bolg`an 
aynadan MB tablitsasi du`zilisi aniqlanadi. 
Mag`liwmatlar bazasin jaratiw ushin aldin ala onin` modelin, yag`niy onin` du`zilmesin islep 
shig`ariw za`rur. Bunin` ushin MB maydan tu`snigi kirtilgen bolip, onin` du`zilmesin aniqlaydi. 
Maydandi aniqlaw to`mendegi elementlerden du`zilgen. 

• Maydan ati (Fields Name); 
• Maydan turi (Type); 
• Maydan o`lshemi (Size); 
• Maydan gilti(Key). 
 

 Maydan ati -10g`a shekem latin ha`ribi ha`m sanlardan du`zilgen boliwi mumkin.  
Maydan tu`rleri tekstli, sa`ne, logikaliq, tusndirme ha`m sanli boliwi mumkin.  
 Maydan o`lshemi-simvol yaki sanlardin` maksimal sani. 
Ma`selen, Dbase MMBS ushin maydan tu`rleri to`mendegiler menen aniqlanadi. 
  - «S» simvoli(tekstli) ma`nislerdi bildirip, onin` uzinlig`i 255 shekem boliwi mu`mkin; 
 - «N» sanli ma`nislerdi bildirip, onin` diapazoni -10307: + 10308 ; 
 - «D» ca`ne(data) ma`nisdi bildirip, onin` o`zgeriw diapazoni01.01.9999 dan 31.12.9999 
shekem; 
 - «L» logikaliq ma`nisti bildirip, «True» ha`m «False» ma`nislerin qabil etedi; 
            - «M» memo (tusinik) bolip, qatarli ma`nislerdi  qabil etedi, ha`r bir qatar 255 ge shekem 
aliwi mumkin. Memo mag`liwmatlari arnawli Dbt ken`eytpeli faylda saqlanadi. 
 MB nin` tu`rli fayllari arasindag`i qatnas birdey atli maydanlar arqali ornatiladi.  MB 
DBF ken`eytirilgen at penen komp`yuter yadinda saqlanadi. 



 Misal1. Misal sipatinda islewshilerdi esapqa aliwdi avtomatlastiriw ma`selesin qarayiq.. 
MB sho`lkemlestiriw ushin aldin onin` kartatekasin islep shig`iw lazim: esapqa aliw ta`rtip 
nomeri; ati ha`m familiyasi; tuwilg`an jili; aylig`i ha`m tag`i basqa. Bulardi esapqa alg`an halda 
MB nin` du`zilisin islep shig`amiz. 

1-tablitsa 
Maydan ati Turi Uzinlig`i Bo`lshek  

bo`legi 
Tusnik 

Kodx 
Famx 
Tyx 
Omx 
MUT 
Lawazim 
Bo’lim 
Ich1 

N 
C 
D 
N 
C 
C 
C 
D 

3 
20 
8 
10 
15 
15 
15 
8 
 

- 
- 
- 
2 
- 
- 
- 
- 

Esapqa aliw ta`rtip nomeri 
Islewshinin` ati ha`m familiyasi 
Tuwilg`an jili 
Aylig`i 
Qa`negeligi 
Lawazimi 
Bo`lim ati 
Iske qabil etilgen kun 

 
 MB tablitsasin jaratiw algoritmi to`mendegi izbe-izlikte orinlanadi: 

1. DataBase DeskTop utilitasi iske tusiriledi. Bunin` ushin to`mendegi buyriqlar izbe-
izligi orinlanadi. 

        Pusk=> Programmi=> Borland Delphi=> DataBase DeskTop 
2. DataBase DeskTop bas menyuinen to`mendegi buyriq orinlanadi. File=>Working 
Directory 
3. Payda bolg`an Set Working Directory dialog aynasinin` Aliasesi dan MB psevdonimi 
aniqlanadi. 
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4. Menyuden File=>New=> Table buyrig`i orinlanadi. 
5. Payda bolg`an Create Table dialog aynasinan MB tu`ri aniqlanadi(ma`selen, Paradox 
yaki Dbase Windows). Bul aynada MB nin` bir neshe tu`rleri bar. 
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6. MB du`zilisi du`ziledi. 
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7. Save As buyrig`i berilip tablitsa ati kiritiledi ha`m OK tuymesi basilip saqlanadi. 
8. Eger MB na mag`liwmatlar kiritiw kerek bolsa menyudan File=> Open buyrig`i 
berilip, keyin fayl tan`lanadi ha`m mag`liwmatlar kiritiledi. 
 

5. MB tablitsasi ushin a`piwayi programma qosimshalarin duziw 
   

 Delphi programmalastiriw ortalig`inda duzilgen qosimshalardi saqlaw ushin joqaridag`i 
duzilgen «Proba» katalogina «App» atli podkatalog duzemiz. Delphi sistemasin iske tu`sirip, 
onin` komponentalar palitrasi qatarinan Data Access ti iske tu`sirip onnan vizual bolmag`an 
komponentasi Ttable alinadi. Ttable komponenti mag`liwmatlardi saqlaw ha`m paydalaniwda 
isletilip, ol mag`liwmatlardi sa`wlelendiriwde vizual komponentalar DTBGrid, Tedit ha`m 
basqalar menen birshelikte isletiledi.Table komponentasin formag`a jaylastirg`annan keyin, 
Object Inspertorida onin` qa`siyetleri to`mendegi izbe-izlikte ornatiladi: 
  - Table komponentasi ajiratiladi(belgilenedi). 
  - Data Base Name MB psevdonimi qa`siyetleri ornatiladi, Proba psevdonimi 
dizimnen alinadi yaki kiritiledi. 
                        - Table Name (MB tablitsasi ati) qa`siyeti ornatiladi (bul jerdeMB  tablitsasi ati 
dizimnen alinadi yaki kiritiledi); 

    - Active qa`siyeti ornatiladi(«True» ma`nisi tan`lanadi). 

 Bul orinlang`an buyriqlardan keyin Ttable komponentasi menen MB tablitsasi arasinda 
baylanis toliq ornatiladi. Ttable komponentasi kibi endi formag`a TData Source  komponentasin 
jaylastiramiz. Bul komponenta vizul ha`m vizual bolmag`an komponentalar arasinda baylanis 
ornatiw ushin xizmet etedi. Sol sebepli TData Source  komponentasina mag`liwmatlar deregi 
deyiledi. TData Source  komponentasi ushin DataSet (mag`liwmatlar toplaminin` ati) qa`siyetleri 
ornatiladi(Table  ati alinadi). 

 Data Controls menyu qatarinan paydalanip formag`a TdbGrid jaylastiramiz ha`m onin` 
DataSuurce qa`siyetin ornatamiz (Data Source1 ma`nisi menen).  Bul TdbGrid komponentasi 
mag`liwmatlar toplaminin` jaziwlarin tablitsa ko`riniste sa`wlelendiriwde xizmet etedi. 

 Islep shig`ilg`an jobani saqlaw ushin menyuden to`mendegi buyriqlar ibe-izligi 
orinlanadi. File=>Save Projekt As. Aldin joba formasi (ma`selen Appl1.pas ati menen), keyin 
jobanin` o`zi (ma`selen Appl1.dpr ati menen) saqlanadi. 

  MB tablitsasi menen islew ushin  a`piwayi qosimsha jaratiw algortmi to`mendegi 
izbe-izlikte orinlanadi: 

1. Delphi sistemasi iske tu`sirilip, BDE komponentalar palitrasinan Ttable komponentasi 
formag`a qoyiladi. 

2.  Formadag`i Ttable komponentasi belgilenip, DataBase Name qa`siyetinde MB nin` 
psevdonimi aniqlanadi. 

3. TableName qa`siyetinen MB tablitsasi ati aniqlanadi. 

4. Active qa`siyeti True ma`nisi menen ornatiladi. 

5. Data Acciss komponentalar palitrasinan TdataSource komponentasi formag`a 
qoyiladi. 



6. TdataSet qa`siyeti Table1 ati menen ornatiladi. 

7. Data Controls komponentalar palitrasinan TDbGrid komponentasi formag`a qoyiladi.       

8. DataSource  qa`siyeti dataSource1 ati menen ornatiladi. 

9. Menyudan File=>Save Project As buyrig`i berilip, aldin forma keyin joba saqlanadi. 
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 10. Jobani iske tusiriw ushin F9 tuymesi basiladi. Na`tiyjede to`mendegi formag`a iye 
bolamiz. 
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6.  TDB Navigator komponentasi. 

MB tablitsasinda mag`liwmatlardi jilistiriw, o`shiriw, jaziwdi jiljitiw ha`m redaktorlaw ushin 
Data Controls komponentalarinda arnawli TDBNavigator komponentasi bar. 

Bul komponentani formadag`i MB tablitsasina to`mendegi ta`rtipte ornatiw mumkin. 

1. MB tablitsasi formasi ekrang`a shaqiriladi. 

2.  Data Controls komponentalar palitrasinan TDBNavigator komponentasi formag`a 
jaylastiriladi.  

3. TDBNavigator komponentalar palitrasinan DataSource  qa`siyeti dataSource1 ati menen 
ornatiladi. 



4. Menyudan File=>Save Project As buyrig`i berilip, aldin forma keyin joba saqlanadi. 

5. Jobani iske tu`siriw ushin F9 tuymesi basiladi. Na`tiyjede tablitsadag`i  mag`liwmatalardi 
suriw, o`shiriw, jaziwdi jiljitiw ha`m redaktorlaw siyaqli tu`ymelerge iye bolg`an 
to`mendegi formag`a iye bolamiz. 
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Komp`yuter to`mendegi programma kodlarin avtomatikaliq ta`rizde duzedi: 

Unit  xodim; 

Interface 

Uses 

 Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms, 

 Dialogs, StdCrids, Grids, DBGrids, DB, DBtables, ExtCtrls, DBCtrls; 

       Type 

          TForm1=class(TForm) 

           Label1:  TLabel;   

                 Tabel; TTabel;     

                 DataSource1:  TDataSource; 

                 DBGrid1:  TDBGrid; 

                  DBNavigator1: TDBNavigator1; 

                 Private 

         { Private declarations } 

                 public 

                    { Private declarations } 

                 End; 

 Var 



     Form1: TForm1; 

             Implementation  

             {$R*.dfm} 

              End. 

 

  

7.  Mag`liwmatlardi izlew ha`m filtrlew 

 
Komponenta TDataset ha`m onin` dawamshilari mag`liwmatalar menen is ju`rtiwde arnawli 

usillarg`a  iye: 

• Maydan ma`nisi boyinsha mag`liwmatti izlew; 

• Mag`liwmatlardi filtrlew; 

• Zakladka qoyiw ha`m og`an o`tiw. 

 Mag`liwmatti izlew.  Ma`lim belgilengen jaziwlardi mag`liwmatlar toplaminan izlep 
tabiw ushin eki usil bar: Locate ha`m Lookup. 

Locate- usili birar maydannin` berilgen jaziwi boyinsha kerekli jaziwdi tabiw imkaniyatin 
beredi.Onin` uliwma ko`rinisi to`mendegishe: 

Function Locate(Const KeyFields:String;Const KeyValues: Variant; Options: 
TLocateOptions): Boolean; 

Bul jerde   

KeyFields-mag`liwmatlardi izlewde qatnasatug`in maydan atlari. Olar bir birinen tochka, utir 
menen ajiratiladi.  

KeyValues- Bir yaki bir neshe izlenetug`in maydan ma`nisleri. Eger izlenetug`in ma`nisler bir 
neshe bolsa, massiv variant funktsiyasi etip beriw zarur. 

Options- Izlenetug`in parametirler toplami. Ol to`mendegi ma`nislerdi saqlawi mukin: 

 loCaseInsensitive. Registrdi esapqa almastan izlew. 

loPartialKey. Maydan ma`nisin toliq berilmegen jag`dayda izlew. Ma`selen, ‘So’ baslanatug`in 
familiyalar izlenetug`in bolsa. Ol jag`dayda mag`liwmatlar toplaminan So menen baslanatug`in  
familiyalar ‘Sobirov’ ha`m  ‘Sattarov’lar tabiladi. 

 Eger izlenip atirg`an jaziw tabilsa, funktsiya Locate – true ma`nisti qaytaradi.   

 Misal2. Misal sipatinda joqarida duzilgen oqitiwshilar mag`liwmatlar bazasin alayiq  
ha`m  MB nan kerekli oqitiwshini izlep tabiw ushin qosimsha jaratayiq.. 

 Qosimshani jaratiw algoritmi: 

1. Delphi di iske tusiremiz. 

2. Formag`a Label1 komponentasin ornatamiz ha`m onin` Caption qa`siyetin 
«Mag`liwmatlar bazasinan izlew» so`zine almastiramiz. 

3. Formag`a DataSourse (Mag`liwmatlar deregi), Query(Soraw) ha`m DBGrid 
komponentalarin jaylastiramiz. Olardin` to`mendegi qa`siyetlerin ornatamiz. 

DataSourcel komponenti 

Qa`siyeti  Ma`nisi 



DataSet Query 

Query l komponenti 

Qa`siyeti  Ma`nisi 

DataBaseName 

RequestLive 

SQL 

ABDU_PR 

 

Select* From Xodims 

DataSourcel komponenti 

Qa`siyeti  Ma`nisi 

DataSource DataSource l 

4. Joqaridag`ilardin` tuwirilig`in tekseriw ushin Query1 komponentasinin` Active 
qa`siyetin True etip ornatamiz. 

5. Data Controls komponentalar palitrasinan TDBNavigator komponentasin 
formag`a jaylastiramiz. 

6. TDBNavigator komponentalar qa`siyetinen DataSource qa`siyetin DataSource1 
ati menen ornatamiz. 

7. Button2  komponentasin formag`a jaylastiramiz ha`m  onin` Caption qa`siyetin 
«Shig`iw» so`zine almastiramiz. 

8. Edit1 komponentasin formag`a jaylastiramiz. 

9. Button2 komponetasin formag`a jaylastiramiz ha`m onin` Caption qa`siyetin 
«Kod boyinsha izlew» so`zine almastiramiz. Na`tiyjede to`mendegi formag`a iye bolamiz. 
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10. «Kod boyinsha izlew» tu`ymesin eki ma`rte tez-tez shiqildatip to`mendegi 
programma kodin kiritemiz. 

Procedure TForm1. Button1 Clic(Cender:TObject); 

Begin 

Query1.Locate(‘Kodx’, Edit1.Text,[LopartialKey, 

LoCaseInsensitive]); 



End; 

Bul jerde ‘Kodx’ –isshiler kodin ko`rsetiwshi maydan ati.11 qosimshani iske tu`siremiz. 

Na`tiyjede to`mendegi forma qosimshasina iye bolamiz: 
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Bul formani iske tu`sirgennen keyin Edit1 redaktorlaw qatarinan kerekli oqitiwshi kodi 
kiritilip «Kod boyinsha izlew» tu`ymesi basiladi. Bul jerde izlew  Kodx maydani boyinsha 
a`melge asiriladi. Izlew 140 kodi kiritilip «Kod boyinsha izlew» tu`ymesi basiladi. Na`tiyjede sol 
kodli isshi tabilg`an, sebebi kursor sol kod tuwirisinda turipti. Buni familiya ha`m ati boyinsha 
da a`melge asiriw mukin. Onin` ushin ‘Kodx’ maydani ornina ‘Famx’ maydanin jaziw jeterli. 

MBnan izlewdi eki maydan boyinsha da sho`lkemlestiriw mumkin, bunin` ushin ekinshi 
redaktorlaw maydanin kiritiw kerek boladi. 

Duzilgen programma kodlari to`mendegishe boladi. 

Unit Xodim1; 

Interface 

Uses 

  Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms, 

    Dialogs, StdCtrls, Orids, DBOrids, DB, DBTables, ExtCtrls, DBCtrls; 

  Type  

     TForm1=class (TForm) 

       DataSourse1: TDataSource; 

       Query1: TQuery1; 

      DBGrid1: DBGrid; 

       Button1: TButton; 

        Button2: TButton; 

        Edit1: TEdit1; 

                    Label 1: TLabel; 

                    DBNavigator1: TDBNavigator1; 

                    Prodcedure Button2 Click(Sender:TObject); 



                 Private 

         { Private declarations } 

                 public 

                    { Private declarations } 

                 End; 

 Var 

     Form1: TForm1; 

             Implementation  

             {$R*.dfm} 

              Prodcedure TForm1.Button2 Click(Sender:TObject); 

              Begin 

              Query1. Locate(‘kodx’, edit1.Text,[LoparnialKey,LoCaseInsensitive]); 

              End; 

               End. 

 

 Endi  TDataSet ob`ekti dawamshisi bolg`an ekinshi LookUp izlew funktsiyasin ko`rip 
shig`amiz. Bul funktsiya ha`m Locate funktsiyasina ju`da` uqsas bolip, onin` ko`rinisi 
to`mendegishe: 

Function LookUp(Const KeyFields: String; Const KeyValues: Variant; const ResultFields: 
String): Variant;  

Bul funktsiyanin` Locate funktsiyasinan o`zgesheligi sonda, ol tabilg`an jaziwdi ha`rekettegi dep 
aniqlamaydi, ol tabilg`an jaziwdin` berilgen maydan ma`nisini qaytaradi.  Tap sonday alding`i 
jag`daydag`i siyaqli onin` parametrleri to`mendegilerdi aniqlaydi. 

 KeyFields- mag`liwmatlardi izlewde qatnasatug`in maydan atlarinin` dizimi. Olar bir-
birinen tochka, utir menen ajiratiladi. 

 KeyValues- bir yaki bir neshe izlenetug`in maydan ma`nisleri. Eger izlenetug`in 
ma`nisler bir neshe bolsa massiv varianti funktsiyasi etip beriw za`rur. 

 Mag`liwmatlardi filtrlew   

 Mag`liwmatlardi filtrlewdin` eki tiykarg`i usili bar: 

• Filtr qa`siyetin isletiw; 

• ONFilterRecord  qayta islewshini sho`lkemlestiriw. 

 Filtr qa`siyeti MB jaziwin qanaatlandiriwshi sha`rtti o`z ishine aladi. Sha`rt salistiriw 
ha`m logikaliq operatorlardi o`z ishine aliwi mumkin. Ma`selen, Kodx>139 and Omx>100000.  
Bul sha`rt bizin` joqarida jaratqan MB ushin kodi139 dan ulken ha`m 100000 nan ulken 
isshilerdi ekrang`a shig`aradi.  

Filter qa`siyetine  sha`rtti kiritiw ushin aldin Query1 komponentasi belgilenedi ha`m ob`ekt 
inspektorinan Filter qa`siyeti tabilip, onin` qatarinan Kodx>139 sha`rti kiritiledi ha`m  
Kodx>139 sha`rti kiritiledi ha`m keyin Filtered qa`siyeti true ma`nisine almastiriladi. 

 

Sorawlar payda etiw 



 Zamanago`y mag`liwmatlardi basqariw sistemalari kerekli mag`liwmatlardi sorawlar 
ja`rdeminde tan`lap aliwg`a imkan beredi. Paydalaniwshi ma`lim qag`iydalarg`a tiykarlanip 
soraw payda etedi, sistema bolsa, sol sorawg`a sa`ykes keliwshi jaziwlardi   ajiratip beredi. 

 Ma`lim talaplarg`a juwap beriwshi jaziwlardi ajiratip aliw ushin Query komponentasinan 
paydalaniladi.  

Query komponentasi qa`siyetleri: 

Qa`siyet                                                                        Sipatlamasi  

Name                                    Komponenta ati. Datasourse komponentasi ta`repinen soraw                                                            

                                             na`tiyjeleri,jaziwlardi ko`riwge imkan beriwshi komponen-  

                                     talar,   misal ushin DBGrid  penen baylanistiriw ushin isletiledi. 

SQL                                       SQL tilinde jazilg`an soraw. 

Active                                    Qa`siyetke True ma`nisi berilgende sorawdi orinlaw   

                                               aktivlesedi. 

 Uliwma jag`dayda tablitsadan jaziwlardi tan`law ushin soraw to`mendegi ko`riniske iye 
boladi: 

 SELECT Maydanlar dizimi FROM Tablitsa WHERE (Sha`rt) ORDER BY Maydanlar 
dizimi . 

 Bul jerde ORDER BY- jaziwlardi ta`rtiplew parametri. 

Misal ushin:  

SELECT Fam, Name FROM ’:Mektep:school.db’ WHERE 

(Class=’10a’) ORDER BY Name, Fam 

Bul soraw «Mektep» mag`liwmatlar bazasinan (school.db talitsasinan) 10-a klass oqiwshilari 
dizimin payda etedi. 

Misal ushin:  

SELECT Fam, Name FROM ’:Mektep:school.db’ WHERE 

(Fam>’K’) and (Fam<’L’) ORDER BY Name, Fam 

Bul soraw familyasi «K» ha`ripten baslaniwshi oqiwshilari dizimin payda etedi.  

Soraw SQL qa`siyetine forma jaratiw yaki programma orinlaniwi protsessinde jaziliwi 
mumkin. 

Forma jaratiw  protsessinde  SQL qa`ciyetine  jaziw  jaziw ushin qatarlar qatari 
redaktorinan paydalanadi. Bul redaktor Object Inspector aynasindag`i SQL qa`siyeti qatarindag`i 
ush tochkali tu`ymeni basiw na`tiyjesinde ashiladi. 

 SQL qa`siyeti qatarlar diziminen ibarat. Programma orinlaniw protsessinde soraw payda 
etiw ushin Add usilinan paydalanip, SQL dizimine qatarlardi qosiw lazim. 

 Bunin` ushin aldin ha`rekettegi sorawdi bekitiw, qatarlar dizimin tazalaw lazim: 

            Query1. Close; 

      Query1. SQL.Clear; 

  Delphi sorawdi qayta islep, na`tiyjeni tablitsa ko`rinisine qaytariwi ushin to`mendegi 
usildi shaqiradi: 

             Query1. Open; 



              To`mende konkret shaxs tuwirisinda mag`liwmatti qidiriw ushin soraw payda etiwshi 
programma bo`legi berilgen. Kidiriw sha`rti Fam maydani ma`nisi Fam o`zgeriwshi ma`nisine 
ten` boliw kerek: 

With form1.Query do begin  
 Close; - zakrit fayl –rezul`tat vipolneniya predidushego zaprosa; 
 SQL. Clear; udalit tekst predidushego zaprosa 
 Zapisivaem noviy zapros v svoystvo SQL;   
 SQL.Add (‘SELECT Fam, Name, Class’); 
 SQL.Add (“FROM’: Shkola:School.db’); 
            SQL.Add (‘WHERE’); 
            SQL.Add (‘Fam=’’+fam+’’’)’); 
 SQL.Add (‘ORDER BY Name, Fam’); 
 Open;// aktiviziruem vipolneniya zaprosa 
 End; 

 

To`mendegi programma ha`mme oqiwshilar yaki bir bo`legi haqqindag`i 
mag`liwmatlardi sorawdi orinlaw arqali shig`ariwg`a imkan beredi. 

 Mag`liwmatlar bazasinda soraw na`tiyjelerin ko`riw ushin DBGrid1 komponentasi 
isletilip, DataSourcel komponentasi arqali Table1 yaki Query komponentasi menen baylanisadi. 
 Tform1. ButtonClick protsedurasi soraw tuymesi basilg`anda orinlanadi. Ol 
paydalaniwshidan qatar qabil etip SQL qa`siyetine jaziw arqali soraw tekstin payda etedi. 
Son`inan bul protsedura Open usilin shaqiriw menen sorawdin` orinlawin aktivlestiredi.    

Tform1.Button2 Click protsedurasi ha`mme jaziwlar tuymesin basiw arqali shaqirilip, 
DataSourcel  komponentasin Table1 komponentasi menen baylanistiradi ha`m pu`tin bazani 
ko`riw rejimine o`tiwin ta`minleydi. 
 Eger soraw  qa`siyetine formani jaratiw protsessinde jazilg`an bolsa, programma 
orinlaniw protsessinde soraw sha`rtin soraw tekstine sa`ykes 5 qatarin almastiriw joli menen 
o`zgertiw mumkin. 
 Ma`selen: 
SELECT DISTINCT Fam, Name, Class FROM’’: Shkola:school.db’’WHERE 
(Class=’10a’) ORDER BY Name,Fam  
Soraw tekstin o`zgertiriwshi instruktsiya to`mendegi ko`riniske iye boliwi mukin: 
 Form1. Query1. SQL[3]:=’(Fam=’’’+fam+’’’)’ 
 Coni itibarg`a aliw lazim, SQL qa`siyeti Tstings tipindegi du`zilme bolip, Qatarlar 
nomerleri nol`den baslanadi.  

 

8. Dinamik jaratiwshi psevdonimler 
 Mag`liwmatlar bazasina usinis etiw ushin psevdonimnen paydalaniw programmanin` 
mag`liwmatlar bazasin ha`m programmani ha`r turli disklerge jaylastiriwg`a imkan beredi. Sol 
menen birge a`piwayi mag`liwmatlar bazalari programma menen birge katalogda jaylasadi. 
Bunday jag`dayda BDEAdminstrator ja`rdeminde psevdonim jaratiwdan waz keship, programma 
orinlaniw protsessinde psevdonim jaratiliwi mukin. 

 To`mendegi programmada «Mektep» mag`liwmatlar bazasi menen baylanisiw ushin 
dinamik jaratiwshi psevdonimnen paydalaniladi.  

«Mektep» mag`liwmatlar bazasi (psevdonim dinamik jaratiladi) 

Unit  school3_; 

Interface 



Uses 

Windows, Messages, SysUtils, Classes, Graphics, Controls, Forms, 

 Dialogs, Orids, DBGrids, DB, DBTables, ExtCtrls, DBCtrls; StdCtrls; 

 Type  

 TForm1=class (TForm) 

 Table1: Ttable; // tablitsa(vsya baza dannix) 

 Query1: TQuery;// zapros(zapisi BD, udovletvoryayushie kriteriyu vibora) 

 DataSourse1: TDataSource;// istochnik dannix-tablitsa ili zapros 

 DBGrid1: DBGrid;// tablitsa dlya otobrajeniya BD ili rezul`tata vipolneniya 

 DBNavigator1: TDBNavigator; 

DBText1: TDBText; 

Button1: TButton;// knopka zaprosa 

Button2: TButton;// knopka vse zapisi 

Prodcedure Button1 Click(Sender:TObject); 

Prodcedure Button2 Click(Sender:TObject); 

 Prodcedure Form Activate(Sender:TObject); 

 Private 

 { Private declarations } 

 public 

  { Private declarations } 

 End; 

 Var 

  Form1: TForm1; 

  Implementation  

 {$R*.dfm} 

// shelchok na knopke Zapros 

 Prodcedure TForm1.Button1 Click(Sender:TObject); 

Var  

Fam:string[30]; 

Begin 

Fam:=InputBox(‘viborka informatsii iz BD’ ‘ukajite familiyu i shelknite na OK’)  

If fam <> «»// pol`zovatel` vvel familiyu 

Then 

Begin 

With form1. Query1 do begin 

Close;// zakrit fayl-rezul`tat vipolneniya predidushego zaprosa 

SQL. Clear;// udalit tekst predidushego zaprosa 



// zapisivaem noviy zapros s svoystvao SQL 

SQL.Add (‘SELECT Fam, Name, Class’); 

SQL.Add (“FROM’: Shkola:School.db’); 

 SQL.Add (‘WHERE’); 

 SQL.Add (‘Fam=’’+fam+’’’)’); 

 SQL.Add (‘ORDER BY Name, Fam’); 

 Open;// aktiviziruem vipolneniya zaprosa 

 End; 

{***drugoy variant izmeneniya kriteriya zaprosa 

If Query1. RecodCount,.0 then 

DataSourse1. DataSet:= Query1// otobrazit rezul`tat vipolneniya zaprosa 

Else begin 

Show Message(’v BD net zapisey, udovletvoryayushix kriteriyu zaprosa.’); 

DataSourse1. DataSet:= Table1; 

End; 

End; 

End; 

// shelchok na knopke Vse zapisi 

Prodcedure TForm1.Button2 Click(Sender:TObject); 

Begin 

DataSourse1. DataSet:= Table1;// istochnik dannix-tablitsa  

End; 

// aktivizatsiya formi 

Prodcedure TForm1. FormActivate(Sender:TObject); 

Begin 

With Session do 

Begin 

ConfigMode:=cmSession; 

try 

Keltirilgen misalda mag`liwmat fayli Data podkataloginda jaylasqan. 

Add StandardAlias mag`liwmatlar bazasi ushin waqitsha psevdonim jaratamiz. 

Add StandardAlias(‘shkola’, 

ExtractFilePath(ParamSTr(0))+Data\’, ‘PARADOX’); 

Table. Active:= True;// otkroem bazu dannix 

Finally 

Confio Mode : = cmAll;  

End; 



End; 

End; 

End. 
 Bul programmada mag`liwmatlar bazasi programmasi jaylasqan kataloginin` Data 
asting`i kataloginda  jaylasqan dep esaplanadi. Psevdonim Tform1.FormActivate 
protsedurasinda jaratiladi. Psevdonim jaratiliwin Add StandardAlias protsedurasi orinlaydi. 
Protsedurag`a parametr sipatinda psevdonim ati ha`m og`an sa`ykes katalog ati beriledi. Katalog 
ati Param Str(0) ha`m ExtractFilePatch funktsiyalarina usinis etiw ja`rdeminde aniqlanadi. 
Birinshi funktsiya ma`nisi – programma faylinin` toliq ati, ekinshisi sol faylg`a jol. Sonday etip 
Add StandardAlias protsedurasina mag`liwmatlar  bazasi kataloginin` toliq ati beriledi.    
 

 
9.  Data  Set  redaktori 

 
 

 Data Set  redaktori Ttable  ha`m Tquery ob`ektleri ja`rdeminde shig`ariliwi mumkin. 
Redaktor menen islew ushin  TQuery formag`a jaylastirip, DBDEMOS psevdonimin 
ornatin`,’’select *from customer’’SQL sorawin kirgizin`, Active qa`siyetine True ma`nisin 
berin`. Ob`ektler insektori joqarisinda eki komponent: Tform ha`m TQuery   jaylasqan.  
 Tquery ob`ektinde tishqanshanin` on` tuymesin basin` ha`m kontekstli menyuda «Fields 
Editor» punktini tan`lan` ha`m DataSet redaktorini ekrang`a shig`arin`. Redaktor ekraninda 
tishqanshanin` on` klavishasin basin` ha`m menyuden ADD buyrig`in tan`lan`- AddFieldes 
dialog aynasi ekrang`a shig`adi.  
 Ko`zde tutilg`ani boyinsha ha`mme maydanlar tan`lang`an. Ha`mme maydandi tan`law 
ushin OK tuymesin basin` ha`m redaktordi bekitin`. Ob`ektler inspektorinda taza ob`ektler payda 
boladi. 
 
Bul jan`a ob`ektler CUSTOMER tablitsasin ko`rsetedi. 
Query1CustNo: TfloatField; 
Query1Commpany: TStringField; 
Query1Addr1: TStingField; 
Query1Addr2: TStingField; 
Query1City: TStingField; 
Query1State: TStingField; 
Query1Zip: TStingField; 
Query1 Country: TStingField; 
Query1 Phone: TStingField; 
Query1FAX: TStingField; 
Query1TaxRate: TFloatField; 
Query1Contast: TStingField; 
 
 Eger bul Query1 ob`ektin Customer dep o`zgertsek to`mendegi atlar payda boladi: 
CustomerCustNo 
CustomerCompany 
Ha`r bir jaratilg`an ob`ekt Tfield klasinin` a`wladi esaplanadi. A`wladtin` tu`ri mag`liwmatlar 
tu`rine baylanisli. Ma`selen, CustNo maydaninin` tu`ri TfloatField, Query1City tipi TstringField. 
 Bul klasslardin` en` tiykarg`i qa`siyeti Value dep ataladi. Bul qa`siyetke to`mendegishe 
usinis etiw mumkin:   

Prodcedure TForm1.Button1 Click(Sender:TObject); 
Var 



D: Double; 
S:string 
Begin 
d:= Query1CustNo.Value; 
S:= Query1Company.Value; 
D:=d+1; 
S=’Zoo’; 
Query1CustNo.Value:=d; 
Query1Company.Value:=S; 
End; 
 

Value ma`nisinin` tu`ri ha`r dayim o`zi tiyisli bolg`an maydan tu`rine sa`ykes keledi. 
Ma`selen, TstingFields ushin-string, TcurrencyFields ushin-double. 
 Eger ha`reketdegi DataSetde maydanlar atin aliw lazim bolsa, FieldName qa`siyetinen 
eki usilda paydalaniw lazim: 
   
S:= Query1 Fields[0]. FieldName; 
S:= Query1CustNo. FieldName; 
Eger maydan menen baylanisli ob`ekt atin aliw lazim bolsa, NAME qa`siyetinen paydalaniw 
lazim: 
S:= Query1 Fields[0].Name; 
S:= Query1CustNo. Name; 
CUSTOMER tablitsasi ushin birinshi misal “CustoNo” qatarin ekinshi misal ’’QueryCustoNO’’ 
qatarin qaytalaydi. 
 
 
 
 
 

 
Мустаил иш вариантлари 

 
Топшириқ вариантлари. 

1. Иститут  талабалари. 
2. Таксипарк. 
3. Корхона ишчи ходимлари. 
4. Савдо растаси иши. 
5. Телефон компанияси абонентлари. 
6. Касалхонадаги касалликлар тарихини юритиш. 
7. Авиакасса. 
8. Мехмонхона. 
9. Қишлоқ фуқаролар йиғинлари. 
10. Солиқлар назоратини юритиш. 
11. Давлат Автомобил назорати иши. 
12. Ички ишлар вазирлиги МБ ва дастури 
13. Банк. 
14. Банк кредит бўлими. 
15. Футбол чемпионати. 



 


